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Using the CLI Mode

Using Packet Tracer Activities

Viewing PDUs

Using the Wizard to Build Activities

Hands-on Activities

Using Packet Tracer Activities

Building an activity Using the Wizard

Agenda

Presenter
Presentation Notes
This slide is to be used to point out the topics that will be address during this session. 

Let the participants know that the majority of time in this session will be spent engaged in hands-on activities.
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The CLI mode in Packet Tracer allows a wide variety of 
commands to be entered

It provides for advanced configuration of devices

Any supported Packet 
Tracer Cisco IOS 
commands may be 
entered in the 
CLI mode

Using the CLI Mode

Presenter
Presentation Notes
Use this slide to point out the differences in using the GUI config mode and the command line interface (CLI). 

Point out the following:

Any command that is available in the Config mode is also available in the CLI mode

CLI allows for more advance configurations

The CLI mode requires knowledge of the IOS command syntax

The CLI mode resembles the CLI of a live router
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Packet Tracer comes with a number of prebuilt 
activities

The activities are divided into groups by course and 
then by skill

The activities provide the user with a set of instructions 
for completing the task

Upon completion the user is provided feedback

Using Packet Tracer Activities

Presenter
Presentation Notes
Use this slide to point out to participants that there are a number of Packet Tracer activities that are already created for use in the classroom. 

There are activities in both the Discovery and Exploration curriculum, but there are also other activities built in to Packet Tracer. 

These activities may be completed independently by the students or can be used as demonstrations in presentations. 
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Packet Tracer activity files may be accessed by going 
to the File menu and selecting Open 

Using Packet Tracer Activities

Presenter
Presentation Notes
Use this slide to point out the location of the activities that are built into Packet Tracer. 
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Packet Tracer activity files may also be accessed 
through the Program Files folder

Using Packet Tracer Activities

Presenter
Presentation Notes
Use this slide to point out the basic path to the Packet Tracer activity files.
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Packet Tracer also provides Word documents that may 
be printed out for each activity file

Using Packet Tracer Activities

Presenter
Presentation Notes
Use this slide to point out that there are accompanying Word docs to go with each PT activity.
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Sample of Word documents from an activity file
Using Packet Tracer Activities

Presenter
Presentation Notes
This slide shows samples of the accompanying Word docs.
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Activities are password protected to keep users from 
modifying them
However, instructors may wish to edit an activity to 
make a correction or create a new activity
To access an activity file for editing, open the desired 
file and then go to the File menu and select Activity 
Wizard

Using Packet Tracer Activities

Presenter
Presentation Notes
Use this slide to point out to participants that they can modify previously created activities. 

They may wish to modify an activity to extend the activity to include additional topics or they may use the activity as a basis to build a new activity.
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When prompted for a password, 
enter one of the following:

discovery1
discovery2
discovery3
discovery4
PT_user!  (used for Exploration)

Using Packet Tracer Activities

Presenter
Presentation Notes
Use this slide to inform participants of the different passwords that are used in the PT activities that are included in the curriculum. 

Point out that the passwords are case sensitive. 

Urge participants not to share these passwords with students in order to maintain the integrity on the activities. 

Once you have gained access to the Activity Wizard you can modify any part of the activity, including the password.





13© 2008 Cisco Systems, Inc. All rights reserved. Cisco Public
BRK-118T
Intermediate Use of PT

Intermediate 
Packet Tracer

Viewing PDUs



14© 2008 Cisco Systems, Inc. All rights reserved. Cisco Public
BRK-118T
Intermediate Use of PT

Intermediate Packet Tracer

The Simulation mode provides the user with an Event 
List of each PDU that was sent

The list shows each 
device the PDU 
interacted with 
in route to 
the destination

Viewing PDUs

Presenter
Presentation Notes
Use this slide to discuss using the Simulation mode to view individual PDU that are sent between devices as they communicate. 
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A wealth of information may be obtained from viewing 
the individual PDUs

Viewing PDUs

Presenter
Presentation Notes
Use this slide to show participants how they can view the details of each packet that is sent on the network by clicking on the colored square on the right side of the Event List.
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Presenter
Presentation Notes
Use this slide to demonstrate the different types of information that can be viewed in the Simulation mode.
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Viewing PDUs

Presenter
Presentation Notes
Use this slide to demonstrate the Challenge Me mode that is available.
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This information was obtained from viewing just one 
PDU as it interacted with one device

Viewing PDUs

Presenter
Presentation Notes
Use this slide to point out to the participants that all the information that was shown in the previous slides came from just one of the packets in the Event List.
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Besides providing a wealth of information, viewing 
the PDUs is also helpful in troubleshooting

Viewing PDUs

Presenter
Presentation Notes
Use this slide to point out to participants that the details shown in the packets can be useful in troubleshooting. 
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Packet Tracer has two wireless devices that may 
be added to networking scenarios 

Intermediate Packet Tracer
Using Wireless Devices

Access Point-PT 
Access Point0

Linksys-WRT300N 
Wireless Router0

Linksys-WRT300N

Access Points

Presenter
Presentation Notes
Use this slide to point out the different wireless devices that are available in PT.
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The access points have configuration settings
Using Wireless Devices

Presenter
Presentation Notes
Use this slide to point out the configuration settings that are available when using a wireless access point.
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The Linksys WRT300N has three view modes:
Physical

Config

GUI

Note the physical
mode (shown in this
graphic) does not 
have any items that
can be changed

Using Wireless Devices

Presenter
Presentation Notes
Use this slide to point out the different modes that are available when using a wireless Linksys WRT300N.
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The Config tab offers two general levels 
of configuration: Global and Interface

The Global Settings only allow the user to change 
the display name of the device

Using Wireless Devices

Presenter
Presentation Notes
Use this slide to point the options that are available when using the Config mode on the Linksys.
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The Interface level allows the user to configure 
the available interfaces

Using Wireless Devices

Presenter
Presentation Notes
Use this slide to point items that can be configured on the interface of the Linksys.
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The GUI tab offers the 
same configurations and 
settings as the  Config tab 
with some additional 
features for port 
forwarding, management, 
and router and network 
status

Make sure you click on the 
Save Settings button at 
the bottom to apply the 
new settings to the 
Linksys WRT300N

Using Wireless Devices

Presenter
Presentation Notes
Use this slide to show the GUI mode that is available when using the Linksys router. 

Be sure to point out the user must click on the Save Settings button at the bottom of the GUI window for the changes to take affect.
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When using a wireless device, the client 
PC must have a wireless module installed 
in order to connect

If security is set on either device, 
the settings must match

Using Wireless Devices

PC-PT 
PC0

Linksys-WRT300N 
Wireless Router0

Presenter
Presentation Notes
Use this slide to point that PCs that are going to be part of a wireless network must have a wireless NIC installed. 

Also if any security settings are enabled on the Linksys, they must match on the PC.
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Users can create custom devices with different module 
configurations pre-installed
Steps to build a custom device:

Build the device with all the modules you need installed
Click Custom Device Dialog in the tool bar
Click Select
Click on the device you built and wish to use as a template
Enter the device name and description in the Device Template 
manager window
Click add when finished

Creating Custom Devices

Presenter
Presentation Notes
Use this slide to discuss why a user might want to create custom device. 

Explain that devices that are modified and frequently used are good candidates for custom devices. 

Discuss the steps used to create and save a custom device in PT.
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Once a custom device has been created, it will be 
available for future use
To access the new device, click on the Custom Device 
icon in the Device-Type Selection Box (1)
Then click on the desired device (2)
The custom device name will appear in the 
Device-Specific Selection (3)

1 2 3

Creating Custom Devices

Presenter
Presentation Notes
Use this slide to show how a user can access a custom device once it has been created.
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You can create a custom device out of any of the 
available devices

Using custom devices can save time in 
building activities

You might think about creating a custom device for 
the type of router you use the most, wireless PCs, or 
WAN emulation clouds

Creating Custom Devices

PC-PT 
PC0

1841 
Router0

Cloud-PT 
Cloud0

Presenter
Presentation Notes
Use this slide to discuss the benefits of creating custom device and what types of devices they might want to consider creating.
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The Activity Wizard in Packet Tracer allows the user 
to create activities that are complete with instructions, 
a criteria for determining completeness of the activity, 
and provide feedback to the activity user

This is a great tool for giving users additional practice 
on configuring devices and troubleshooting the 
network design

It is also an excellent tool for assessing the user’s skills

Using the Wizard to Build Activities

Presenter
Presentation Notes
Use this slide to introduce participants to the concept of creating their own PT activities and discuss why they might consider creating activities.
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The Activity Wizard may be accessed by clicking on 
the file menu and then selecting Activity Wizard

Using the Wizard to Build Activities

Presenter
Presentation Notes
Use this slide to point out to participants that the Activity Wizard is used to create a new PT activity. 

This slide describes how to access the Activity Wizard. 

Point out to participants that during this session they will have the opportunity to create a PT activity.
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Information about using the Activity Wizard and other 
Packet Tracer features may be obtained by clicking 
on the Help menu and selecting contents

Using the Wizard to Build Activities

Presenter
Presentation Notes
Use this slide to point the Help feature and tutorials that are available in PT.
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Ten PT 5.0 Talking Points
PT 5.0 is FREE for all Academy students and instructors
PT 5.0 is a powerful tool for network MODEL building
PT 5.0 is not a replacement for REAL equipment and 
Wireshark
PT 5.0 SIMULATION mode offers powerful visualizations
PT 5.0 PHYSICAL mode offers context
PT 5.0 has most of the important CCNA-level PROTOCOLS
PT 5.0 runs on more PLATFORMS like Vista and Linux
PT 5.0 has a MULTI-USER feature; it is a network application
PT 5.0 has an improved ACTIVITY WIZARD – please try it!
Please SHARE your insights, activities, tutorials, and feedback
BONUS: API, External Applications, Portal in near future
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The Evolution of PT5.0 – What’s New
Expanded platform support 

Now runs on Windows (WinXP, Win2k), Vista (Vista Basic, Vista 
Premium), and
Linux (Ubuntu, Fedora)

Enhanced protocol support 
Expanded list of protocols to reflect current networking trends and 
practices in industry and government 
More support for teaching CCNA-level commands 
Deeper modeling for existing protocols

Multiuser functionality
From individual to social learning
PT 5.0 is now a network-capable (peer to peer) application
Instead of students working alone, PT 5.0 supports collaboration, 
competition, remote instructor-student interaction, social networking, 
gaming
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Protocols Modeled:
Protocols are a good way to describe a simulator’s 

power

HTTP, TFTP, Telnet, SSH, DNS, DHCP

TCP and UDP

IPv4, ICMP, ARP, IPv6, ICMPv6

RIPv1/v2/ng, Multi-Area OSPF, EIGRP, Static Routing, 
Route Redistribution, Multilayer switching

Ethernet (802.3), HDLC, Frame Relay, PPP 

STP, RSTP, VTP, DTP, CDP, 802.1q, PAgP

802.11
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PC 1

PC 3

PC 2

2 teams, 

1 instructor 3 different 

classes

3 students 

from home

Multi-user Collaboration and Competition

Presenter
Presentation Notes
PT 5.0 is a network-capable (peer to peer) application. Using the network to teach networking. 

If PT 5.0 on MY computer can communicate with PT 5.0 on YOUR computer, we can have Collaborative and Competitive Network building, using the real network to carry the Packet Tracer virtual packets

This connectivity between multiple instances of PT will support teamwork, classroom games, instructor consoles, and remote instructor-student and student-student interactions
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(ontology) PathsEvidence
Weights

Binary
Weights

Observable level 
Diagnostic Feedback 

Possible
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Impact Summary of New PT 5.0 Features

On Students On Instructors On Authors

Additional 
Platforms

Ability to run PT on more 
operating systems, 
supports more out of 
classroom environments

Ability to run PT on more 
operating systems both 
in and out of classroom

Improved support for 
authoring on more operating 
systems

More 
Protocols

Free practice and 
visualization environment 
for crucial networking 
technologies

Ability to use PT to teach 
more topics (like IPv6)

Improved support for creating 
CCNA-level curriculum and 
assessments

New 
Multiuser 
Feature

More collaboration, 
competition, and fun

More support for social 
learning processes

More instructional design 
possibilities
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Q and A

Glenn Wright ~ glwright@esc11.net
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